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Preface
The instructions in this guide specify how to install the DFsend application and use it to transmit PDF study documents to
a DFdiscover study server.
Images in this guide are of DFsend running in Windows 10. Functionality is identical on all operating systems, and images
are similar, except for window decorations.
Instructions to "select" an object require either clicking the object using the mouse, or moving the focus to it using the
keyboard and pressing space or Return.
Instructions to select Menu > Option refer to the selection of options from the application menubar. For example, to open
the Preferences dialog, select File > Preferences.
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Chapter 1. Introduction
This chapter introduces DFsend and provides prerequisites for it's installation and use.

1.1. What is DFsend?
DFsend is a desktop application providing functionality for users who need to securely transmit scanned PDF study
documents from a local computer to a DFdiscover study server, over the internet, without requiring direct access to a specific
study database.
DFsend includes user authentication, encryption and tracking and provides a safe and reliable alternative to faxing or
emailing study CRFs to a DFdiscover server.
The next chapter describes the steps for installing the DFsend application and getting started. This is followed by a chapter
that explains how to use DFsend, and ending with a chapter that describes transmission logging.

1.2. Prerequisites
There are several methods for creating an electronic PDF copy of one or more paper forms. The most common is to use a
scanner. Scanners are typically standalone hardware devices or part of a multi-function device that also includes copying
and printing.
The most important prerequisite when using a scanner is to ensure that the scan settings are compatible with the expectations
and limitations of the image processing in DFdiscover. This typically manifests itself in two places:
• Scanned documents may be B&W (black and white), grayscale or color. B&W scans create files that are smaller than
grayscale or color scans, and hence B&W scans are quicker to send.
Scan resolution must be between 100 and 300 dpi. The higher the resolution, the clearer the document, but this also
creates a larger file size, which takes longer to transmit. 200 dpi is generally an acceptable compromise between higher
scan quality and smaller file size.
• The page size must be US Letter (8.5 x 11 inches, 216 x 279 mm) or A4 (8.27 x 11.7 inches, 210 x 297 mm). Other page
sizes will lead to cropping or scaling of the result, yielding pages that look incorrect in DFdiscover. If the scanner has an
automatic sheet-feed mechanism, ensure that the paper guides are set snug to the width of the paper.
If you are using DFsend on a regular basis, it is worthwhile implementing and following a local filenaming convention. Having
a standard naming method and consistent use of folder locations for documents that you have scanned and transmitted
will simplify your work process.
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Chapter 2. Getting Started
This chapter covers the installation of the DFsend application and login instructions.

2.1. Installation
The DFsend application is available for Windows and macOS. It must be installed on the local computer before use.
Windows Installation.

Installation and proper operation of the DFsend application requires Windows 10.

1. The Windows application is distributed as a Windows msi installer file. The file, named dfsend.msi, is available for
download from www.dfnetresearch.com in the Client Support section. It may also be available from the study sponsor.
2. Download the installer file to the local computer.
3. Double-click the dfsend.msi file. Installation begins automatically. Installation must be performed on the local computer.
4. Once complete, the installer adds the DFsend icon to the desktop as well as an entry in the Start menu.
macOS Installation.

Installation and proper operation of the DFsend application requires macOS 10.14 (Mojave) or later.

1. The macOS DFsend client is distributed as a pkg installer file. The file, named DFsend.pkg, is available for download
from www.dfnetresearch.com in the Client Support section. It may also be available from the study sponsor.
2. Download the installer file to the local computer.
3. Double-click the DFsend.pkg file.
4. Follow the on-screen instructions in the installation program. Installation must be performed on the local computer.
5. Once complete, the installer adds the DFsend icon to the Applications menu.

2.2. Login
Sending scanned PDF documents to a study requires login credentials for the DFdiscover server where the study is hosted.
This also requires an internet connection. The study coordinating site will have provided you with:
• access to the DFsend download
• the name of the DFdiscover Server
• a unique username, and
• an initial password.
DFsend may be installed as an icon on your desktop or as a menu item in your Start menu (Applications menu in macOS).

Launching DFsend displays the login dialog.
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Each use of DFsend requires login using your unique credentials. To complete login:
1. Optional: In some configurations, your local IT infrastructure may require a proxy server for applications that connect to
the internet. Your local IT department will supply the necessary information. To configure local proxy server settings, click
Proxy Config at the top of the login screen. Complete the required fields in the sub-dialog. Click Home to return.
1

2. Enter the name of the DFdiscover Server. There may be a slight pause after entering the name while DFsend is
locating and resolving the entered server name. The right-half of the login dialog updates if the DFdiscover administrator
has specified a custom banner.
3. Enter your credentials in the Username and Password fields. Credentials unique to you are provided by the DFdiscover
or study administrator.

1

Technically, this is the FQDN (fully-qualified domain name) of the server - in local installations, it may be only a local name, but more typically is a full
.com, .org, .edu, etc, domain name.
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Figure 2.1. Completed Login dialog

4. Click Login to complete the login.
5. If there is an error, an information message is displayed in the login dialog. The error must be corrected before you can
proceed.
2

6. If the server and credentials are correct , the login dialog is dismissed and the main DFsend window is presented.
The administrator of the DFdiscover Server may have enabled two-factor authentication for your login account. If it is enabled,
after successful authentication the login screen updates to request the security code. Independently you will receive an
email with the 6-digit security code. The email is sent to the email address on file for the account. Enter the 6-digit security
code in the field labeled Please enter the security code that we just sent you. After entering the code, click Login again
to complete login.
DFsend remembers your most recent servers (and proxy servers), so you need to enter the DFdiscover Server information
once. If you are using DFsend with multiple servers, use the pull-down for the DFdiscover Server field to select a previous,
recent value.
Your Username and Password must be entered each time you login. All pages transmitted with DFsend are logged with
the username. Like any computer system, be vigilant to protect your username and password, and immediately report any
suspicious account activity to your IT department and the study coordinating site.
2

If this is your first time using your username and password, or you have been provided a one-time reset password, you are prompted to choose a new
password before proceeding.
It is also possible that the password expiry period has elapsed and you are prompted to choose a new password.

4

Chapter 2. Getting Started

DFsend includes password aging, an FDA regulatory requirement. With password aging you will be requested to specify a
new password at regular intervals. The password interval is set by the DFdiscover administrator at the study coordinating site.

2.3. Exiting DFsend
When you have completed transmission of documents for a session, choose File > Exit to exit DFsend and terminate the
application. Since all activity is recorded using the login username, it is important to not leave DFsend unattended or open
on your desktop.
To prevent unattended use of DFsend, an autologout interval of 15 minutes is enforced. If DFsend is idle for the autologout
interval, it automatically closes the current login session.

To continue, click Login again, or Exit and restart DFsend.
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This chapter describes how to use DFsend to send PDF files to a DFdiscover study server.

3.1. The Main Window
After successful login to DFsend, the main window is presented.

PDFs to send are added to the list area (Drop PDFs here) and there are several action buttons to act on the current items
in the list.
When DFsend is opened for the first time, the list is empty and the only available action is Add

3.2. Adding Files for Transmission
Any PDF file(s) to be sent to the DFdiscover study server must be added to the list area in order to be processed. PDF
files can be added in one of two ways:
1. Click Add. From the Select PDF Files file selection dialog, locate the desired PDF files on the local computer, select
them and close the file selection dialog.
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2. Or, drag-and-drop the desired PDF files from a local file folder directly into the list area.
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Both of these actions can be repeated as needed to add files from different locations.
Only PDF files may be loaded and sent by DFsend. It is not possible to add files having extensions other than .pdf to the
list area, either by drag-and-drop or by using the file selection dialog.
Files that have been loaded but not yet sent, are displayed with their full path name. There is no Status available for files
that have not yet been sent.

3.3. Remove Added Files
Any PDF file to be sent, that has been added to the list area, may be deleted prior to sending.
To delete a recently added file, select its entry and click Remove.
To remove all files in the list area, type Ctrl+A (or select a subset of files) and click Remove .

3.4. Sending Files to the DFdiscover Server
A typical workflow is to add several documents and then send them with one action. In this scenario, each document is sent
separately, but with one single action. It is also possible to add and send a single file at a time.
After clicking Send, each PDF file identified in the list area is sent to the DFdiscover study server.
Each time you send documents, sender verification occurs and you are prompted to confirm your identity - this is in keeping
with the requirements of 21 CFR Part 11. For each login session, the first verification requires username and password.
1
Subsequent transmissions in the same login session require the password only.
1

Multiple consecutive attempts to confirm with invalid credentials causes sending to fail, the user to be logged out and a notification email to be sent to
the administrator. The specific number of consecutive attempts is determined and set by the administrator.
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Once you have entered your credentials and clicked OK, sending begins at the first file in the list and proceeds one file at
a time down the list. While files are being sent, a progress dialog is displayed.
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As each file completes, the Status column for that entry is updated to display the file's transmission status.
Once the transmission of all files has completed, the summary dialog is presented.
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When the summary dialog is closed, the list area is cleared of all successful transmissions. If there were any failures, entries
for the failed transmissions remain in the list area for the current DFsend session. This makes it easy to re-attempt sending.
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3.4.1. Processing After Transmission
Files submitted successfully to the DFdiscover server are processed in the same manner as pages sent by email or fax. Any
barcoded pages are submitted to the new record queue for the appropriate study, where they can be retrieved and entered
using DFexplore in Image View. Pages without barcodes are forwarded to the Image Router.

3.5. Canceling File Transmissions
Once Send is clicked and valid credentials are provided, all PDF documents in the list area are queued for sending. If more
than one document is being sent, Cancel is enabled and can be clicked to cancel the queued, and not yet sent, documents.
If only one file has been loaded and queued for sending, the in-progress transmission cannot be canceled. Hence, Cancel
in the progress dialog is not enabled.
Clicking Cancel can abort the transmission of those PDF documents that have not yet been sent. Cancel cannot abort the
transmission that is in progress, nor can it undo any transmission that has already occurred.

3.6. Preferences
DFsend has one preference that can be set at the user level. The preference controls the behavior of DFsend when it starts,
specifically in relation to memory of previously failed transmissions:
• do not reload failed PDFs - PDFs that failed to send in the current DFsend session are not reloaded into the next session
once the existing session is closed,
• reload failed PDFs from preceding session - failed PDFs for the current DFsend session are reloaded into the next
session once the current session is closed.
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Preferences are user-specific. Any change to preference setting is applied immediately and is preserved across DFsend
sessions.

3.7. User Profile, Change Password
When the DFdiscover administrator created your account, they defined a user profile for you. That profile includes your
name, your mailing address, your contact information and your password.
You can examine your current user profile by choosing File > User Profile....

2

Values below the horizontal rule can be edited. It is not possible to change your Username, Full Name, or Email . Edited
values are saved when clicking OK.
2

The DFdiscover administrator can centrally update the Full Name or Email if necessary.
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You can change your password at any time by clicking Change Password... . The dialog requires you to enter a new password
and then re-type it to confirm the changed password.

3.8. Auto Logout
To meet regulatory requirements and prevent unattended use, DFsend has an Auto Logout feature that closes the
application after 15 minutes of inactivity. If DFsend is idle for the interval, it automatically closes the current login session.

To continue, click Login again, or Exit and restart DFsend.
If Auto Logout occurs when there are documents that have been queued but not sent, these documents are cleared.
Any keyboard input or mouse movement inside DFsend resets the Auto Logout timer. Auto Logout also does not occur
during file transmission. Once a transmission has completed, the timer is reset.

3.9. Certificate Info
14
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DFsend communicates with the DFdiscover server using HTTPS on port 443. This port must be open on any firewalls
between the local computer and the study server.
This is industry-standard technology that encrypts the bi-directional communication using a 'certificate of trust' provided by
the server. It is the same technology used by banks and the majority of secure, global web services.
You can visually confirm that the communication is secure. Select Help > Certificate Info and look for the green checkmark.
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This chapter describes the send logging capabilities of DFsend.

4.1. Accessing the Send Log
DFsend keeps a log of all transmission activity for each user.
By default, the send log is not visible. Click Show Log to display the historical log of PDF documents that you have sent
from the current computer.

The log lists the PDF documents sent by you (the login user) from the current computer, the status and the date/time. The
log does not show transmissions made by you on other computers, or by other users on the same computer.
The total number of log entries and the total number of successful transmissions appear in the header of the log window.
Each time a PDF file is sent an entry for the transmission is added to the head of the log file. Send logging includes the full
path and name of the sent PDF file, the transmission status and the date and time that the file was submitted by the user.
To close the log window, click Hide Log. Closing the log does not delete or clear log entries.

4.1.1. Clear Log
To clear or delete some, or all, log entries for your current and previous DFsend sessions on this computer, click Clear Log... .
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It is possible to selectively clear some log entries. Selecting all entries removes all transmission entries belonging to you
from the log on this computer. Selecting entries older than ## days clears only those log entries that are older than the
specified number of days. 30 days is the default, but this can be changed to any number of days between 1-999.
Entries for transmissions made by other users or by yourself on a different computer are not included or impacted.
Clearing entries from the send log does not remove any content from the study server. For example, selecting Page >
Context in DFexplore will always show who sent the page and when it arrived.

4.2. Exporting the Send Log
Several actions can be applied to the send log. When the log is visible, you can:
• save the log as a PDF file,
• save the log as a CSV file,
• print the log.
To export the send log, click Export Log.... This opens the Export Log dialog.

17

Chapter 4. Send Logging

From the dialog,
• Choose the type of logged transmission: all, success or failure.
• Optionally, check Include Send Dates and enter a date range to filter log entries of interest. If Include Send Dates is not
checked, no date filtering is applied.
• To export log entries to a file, enter a complete path and file name in Output File (including the appropriate file extension)
and click OK. If printing, leave Output File blank and click Print.
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Appendix A. Copyrights - Acknowledgments
A.1. External Software Copyrights
DFdiscover software uses several third-party software components as part of its server side and/or client tools.
The copyright information for each is provided below. If you would like to receive source codes of these third-party
components, please send us your request at <help@dfnetresearch.com>.

A.1.1. DCMTK software package
Copyright © 1994-2011, OFFIS e.V. All rights reserved.
This software and supporting documentation were developed by
OFFIS e.V.
R&D Division Health
Eschereg 2
26121 Oldenburg, Germany
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:
• Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.
• Neither the name of OFFIS nor the names of its contributors may be used to endorse or promote products derived from
this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

A.1.2. Jansson License
Copyright © 2009-2014 Petri Lehtinen <petri&digip.org>
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the “Software”), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
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DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

A.1.3. Mimencode
Copyright © 1991 Bell Communications Research, Inc. (Bellcore)
Permission to use, copy, modify, and distribute this material for any purpose and without fee is hereby granted, provided
that the above copyright notice and this permission notice appear in all copies, and that the name of Bellcore not be
used in advertising or publicity pertaining to this material without the specific, prior written permission of an authorized
representative of Bellcore. BELLCORE MAKES NO REPRESENTATIONS ABOUT THE ACCURACY OR SUITABILITY OF
THIS MATERIAL FOR ANY PURPOSE. IT IS PROVIDED “AS IS”, WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES.

A.1.4. RSA Data Security, Inc., MD5 message-digest algorithm
Copyright © 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. License to copy and use this software
is granted provided that it is identified as the “RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material
mentioning or referencing this software or this function. License is also granted to make and use derivative works provided
that such works are identified as “derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material
mentioning or referencing the derived work. RSA Data Security, Inc. makes no representations concerning either the
merchantability of this software or the suitability of this software for any particular purpose. It is provided “as is” without
express or implied warranty of any kind. These notices must be retained in any copies of any part of this documentation
and/or software.

A.1.5. mpack/munpack
Copyright © 1993,1994 by Carnegie Mellon University All Rights Reserved.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the name of Carnegie Mellon University not be used in
advertising or publicity pertaining to distribution of the software without specific, written prior permission. Carnegie Mellon
University makes no representations about the suitability of this software for any purpose. It is provided “as is” without
express or implied warranty.
CARNEGIE MELLON UNIVERSITY DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING
ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL CARNEGIE MELLON
UNIVERSITY BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

A.1.6. TIFF
Copyright © 1988-1997 Sam Leffler Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted
without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software
and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
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INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF
DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

A.1.7. PostgreSQL
Portions © 1996-2019, PostgreSQL Global Development Group Portions © 1994, The Regents of the University of California
Permission to use, copy, modify, and distribute this software and its documentation for any purpose, without fee, and without
a written agreement is hereby granted, provided that the above copyright notice and this paragraph and the following two
paragraphs appear in all copies.
IN NO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING OUT OF THE USE
OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF THE UNIVERSITY OF CALIFORNIA HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
THE UNIVERSITY OF CALIFORNIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND THE UNIVERSITY OF CALIFORNIA HAS NO
OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

A.1.8. OpenSSL License
Copyright © 1998-2019 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This
product includes software developed by the OpenSSL Project for use in .the OpenSSL Toolkit.” (http://www.openssl.org/)
4. The names “OpenSSL Toolkit” and "OpenSSL Project" must not be used to endorse or promote products derived from
this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in their names without
prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes software
developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org)”
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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This product includes cryptographic software written by Eric Young (<eay@cryptsoft.com>). This product includes
software written by Tim Hudson (<tjh@cryptsoft.com>).

A.1.9. Original SSLeay License
Copyright © 1995-1998 Eric Young (<eay@cryptsoft.com>) All rights reserved.
This package is an SSL implementation written by Eric Young (<eay@cryptsoft.com>). The implementation was written
so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following
conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code.
The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim
Hudson (<tjh@cryptsoft.com>).
Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is
used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the
form of a textual message at program startup or in documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: “This
product includes cryptographic software written by Eric Young (<eay@cryptsoft.com>)” The word “cryptographic” can
be left out if the rouines from the library being used are not cryptographic related :-).
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must
include an acknowledgement: “This product includes software written by Tim Hudson (<tjh@cryptsoft.com>)”
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this
code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

A.1.10. gawk
GNU GENERAL PUBLIC LICENSE Version 2, June 1991
http://www.gnu.org/licenses/gpl-2.0.html
Copyright © 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor,
Boston, MA 02110-1301, USA
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Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software--to make sure the software
is free for all its users. This General Public License applies to most of the Free Software Foundation's software and to any
other program whose authors commit to using it. (Some other Free Software Foundation software is covered by the GNU
Lesser General Public License instead.) You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make
sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive
source code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and
that you know you can do these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the
rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the
rights that you have. You must make sure that they, too, receive or can get the source code. And you must show them
these terms so they know their rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.
Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty
for this free software. If the software is modified by someone else and passed on, we want its recipients to know that what
they have is not the original, so that any problems introduced by others will not reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of
a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this, we have
made it clear that any patent must be licensed for everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
1. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be
distributed under the terms of this General Public License. The “Program”, below, refers to any such program or work, and
a “work based on the Program” means either the Program or any derivative work under copyright law: that is to say, a work
containing the Program or a portion of it, either verbatim or with modifications and/or translated into another language.
(Hereinafter, translation is included without limitation in the term “modification”.) Each licensee is addressed as “you”.
Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running the Program is not restricted, and the output from the Program is covered only if its contents constitute
a work based on the Program (independent of having been made by running the Program). Whether that is true depends
on what the Program does.
2. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty;
keep intact all the notices that refer to this License and to the absence of any warranty; and give any other recipients of
the Program a copy of this License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.
3. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program,
and copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all
of these conditions:
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a. You must cause the modified files to carry prominent notices stating that you changed the files and the date of any
change.
b. You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program
or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.
c. If the modified program normally reads commands interactively when run, you must cause it, when started running for
such interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright
notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute
the program under these conditions, and telling the user how to view a copy of this License. (Exception: if the Program
itself is interactive but does not normally print such an announcement, your work based on the Program is not required to
print an announcement.) These requirements apply to the modified work as a whole. If identifiable sections of that work
are not derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when
you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole
must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to
each and every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.
4. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you also do one of the following:
a. Accompany it with the complete corresponding machine-readable source code, which must be distributed under the
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
b. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete machine-readable copy of the corresponding source code,
to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,
c. Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative
is allowed only for noncommercial distribution and only if you received the program in object code or executable form
with such an offer, in accord with Subsection b above.) The source code for a work means the preferred form of the
work for making modifications to it. For an executable work, complete source code means all the source code for
all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and
installation of the executable. However, as a special exception, the source code distributed need not include anything
that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.
5. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your
rights under this License. However, parties who have received copies, or rights, from you under this License will not have
their licenses terminated so long as such parties remain in full compliance.
6. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission
to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this
License. Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your
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acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Program
or works based on it.
7. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a
license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible
for enforcing compliance by third parties to this License.
8. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions
of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may
not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program
by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this
License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section
is intended to apply and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity
of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system,
which is implemented by public license practices. Many people have made generous contributions to the wide range of
software distributed through that system in reliance on consistent application of that system; it is up to the author/donor
to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
9. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Program under this License may add an explicit geographical distribution
limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such
case, this License incorporates the limitation as if written in the body of this License.
10.The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time.
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version or of
any later version published by the Free Software Foundation. If the Program does not specify a version number of this
License, you may choose any version ever published by the Free Software Foundation.
11.If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write
to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally. NO
WARRANTY
12.BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
13.IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED
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ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

A.1.11. Ghostscript
The files in the base, psi, lib, toolbin, examples, doc and man directories (folders) and any subdirectories (sub-folders)
thereof are part of GPL Ghostscript.
The files in the Resource directory and any subdirectories thereof are also part of GPL Ghostscript, with the explicit exception
of the files in the CMap subdirectory (except “Identity-UTF16-H”, which is part of GPL Ghostscript). The CMap files are
copyright Adobe Systems Incorporated and covered by a separate, GPL compatible license.
The files under the jpegxr directory and any subdirectories thereof are distributed under a no cost, open source license
granted by the ITU/ISO/IEC but it is not GPL compatible - see jpegxr/COPYRIGHT.txt for details.
GPL Ghostscript is free software; you can redistribute it and/or modify it under the terms the GNU General Public License
as published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version.
GPL Ghostscript is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for
more details.
You should have received a copy of the GNU General Public License along with this program so you can know your rights
and responsibilities. It should be in a file named doc/COPYING. If not, write to the
Free Software Foundation, Inc., 59 Temple Place Suite 330, Boston, MA
02111-1307, USA.
GPL Ghostscript contains an implementation of techniques covered by US Patents 5,055,942 and 5,917,614, and
corresponding international patents. These patents are licensed for use with GPL Ghostscript under the following grant:
Whereas, Raph Levien (hereinafter “Inventor”) has obtained patent protection for related technology (hereinafter “Patented
Technology”), Inventor wishes to aid the the GNU free software project in achieving its goals, and Inventor also wishes to
increase public awareness of Patented Technology, Inventor hereby grants a fully paid up, nonexclusive, royalty free license
to practice the patents listed below (“the Patents”) if and only if practiced in conjunction with software distributed under the
terms of any version of the GNU General Public License as published by the
Free Software Foundation, 59 Temple Place, Suite
330, Boston, MA 02111.
Inventor reserves all other rights, including without limitation, licensing for software not distributed under the GNU General
Public License.
5055942 Photographic image reproduction device using digital halftoning to para images allowing adjustable coarseness
5917614 Method and apparatus for error diffusion paraing of images with improved smoothness in highlight and shadow
regions

A.1.12. MariaDB and FreeTDS
GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999 http://www.gnu.org/licenses/lgpl-2.1.html
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Copyright © 1991, 1999
Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License,
version 2, hence the version number 2.1.]
Preamble The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public Licenses are intended to guarantee your freedom to share and change free software--to make sure
the software is free for all its users.
This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries-of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think
carefully about whether this license or the ordinary General Public License is the better strategy to use in any particular
case, based on the explanations below.
When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you
receive source code or can get it if you want it; that you can change the software and use pieces of it in new free programs;
and that you are informed that you can do these things.
To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you
modify it.
For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that
we gave you. You must make sure that they, too, receive or can get the source code. If you link other code with the library,
you must provide complete object files to the recipients, so that they can relink them with the library after making changes
to the library and recompiling it. And you must show them these terms so they know their rights.
We protect your rights with a two-step method:
1. we copyright the library, and
2. we offer you this license, which gives you legal permission to copy, distribute and/or modify the library.
To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is
modified by someone else and passed on, the recipients should know that what they have is not the original version, so that
the original author's reputation will not be affected by problems that might be introduced by others.
Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company
cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we
insist that any patent license obtained for a version of the library must be consistent with the full freedom of use specified
in this license.
Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the
GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary General
Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally
speaking a combined work, a derivative of the original library. The ordinary General Public License therefore permits such
linking only if the entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria
for linking other code with the library.
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We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the ordinary
General Public License. It also provides other free software developers Less of an advantage over competing non-free
programs. These disadvantages are the reason we use the ordinary General Public License for many libraries. However,
the Lesser license provides advantages in certain special circumstances.
For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so
that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent
case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting
the free library to free software only, so we use the Lesser General Public License.
In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large
body of free software. For example, permission to use the GNU C Library in non-free programs enables many more people
to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program
that is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.
The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference
between a “work based on the library” and a “work that uses the library”. The former contains code derived from the library,
whereas the latter must be combined with the library in order to run.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
1. This License Agreement applies to any software library or other program which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also
called “this License”). Each licensee is addressed as “you”.
A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application
programs (which use some of those functions and data) to form executables.
The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work
based on the Library” means either the Library or any derivative work under copyright law: that is to say, a work containing
the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language.
(Hereinafter, translation is included without limitation in the term “modification”.)
“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete
source code means all the source code for all modules it contains, plus any associated interface definition files, plus the
scripts used to control compilation and installation of the library.
Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running a program using the Library is not restricted, and output from such a program is covered only if its
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether
that is true depends on what the Library does and what the program that uses the Library does.
2. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer
of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy
of this License along with the Library.
You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.
3. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and
copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of
these conditions:
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a. The modified work must itself be a software library.
b. You must cause the files modified to carry prominent notices stating that you changed the files and the date of any
change.
c. You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.
d. If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that
uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith
effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and
performs whatever part of its purpose remains meaningful. (For example, a function in a library to compute square
roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that
any application-supplied function or table used by this function must be optional: if the application does not supply it,
the square root function must still compute square roots.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Library, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the
same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every
part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.
4. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of
the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU
General Public License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU
General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other
change in these notices.
Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License
applies to all subsequent copies and derivative works made from that copy.
This option is useful when you wish to copy part of the code of the Library into a program that is not a library.
5. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machinereadable source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange.
If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access
to copy the source code from the same place satisfies the requirement to distribute the source code, even though third
parties are not compelled to copy the source along with the object code.
6. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being
compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative work of the
Library, and therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the Library
(because it contains portions of the Library), rather than a “work that uses the library”. The executable is therefore covered
by this License. Section 6 states terms for distribution of such executables.
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When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work
may be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if
the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely
defined by law.
If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small
inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally
a derivative work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of
Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with
the Library itself.
7. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the Library
to produce a work containing portions of the Library, and distribute that work under terms of your choice, provided
that the terms permit modification of the work for the customer's own use and reverse engineering for debugging such
modifications.
You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use
are covered by this License. You must supply a copy of this License. If the work during execution displays copyright
notices, you must include the copyright notice for the Library among them, as well as a reference directing the user to
the copy of this License.
Also, you must do one of these things:
a. Accompany the work with the complete corresponding machine-readable source code for the Library including
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is
an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object code
and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the contents of definitions files in the Library will not
necessarily be able to recompile the application to use the modified definitions.)
b. Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that
i. uses at run time a copy of the library already present on the user's computer system, rather than copying library
functions into the executable, and
ii. will operate properly with a modified version of the library, if the user installs one, as long as the modified version
is interface-compatible with the version that the work was made with.
c. Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.
d. If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy
the above specified materials from the same place.
e. Verify that the user has already received a copy of these materials or that you have already sent this user a copy. For
an executable, the required form of the “work that uses the Library” must include any data and utility programs needed
for reproducing the executable from it. However, as a special exception, the materials to be distributed need not include
anything that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.
It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot use both them and the Library together in
an executable that you distribute.
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f. You may place library facilities that are a work based on the Library side-by-side in a single library together with
other library facilities not covered by this License, and distribute such a combined library, provided that the separate
distribution of the work based on the Library and of the other library facilities is otherwise permitted, and provided that
you do these two things:
a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other
library facilities. This must be distributed under the terms of the Sections above.
b. Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.
g. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights, from you
under this License will not have their licenses terminated so long as such parties remain in full compliance.
h. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission
to modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept
this License. Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your
acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library
or works based on it.
i. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license
from the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible
for enforcing compliance by third parties with this License.
j. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy both
it and this License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply, and the section as a whole is intended to apply in other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system which is implemented by public license practices. Many people have made generous contributions to the wide
range of software distributed through that system in reliance on consistent application of that system; it is up to the
author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.
k. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Library under this License may add an explicit geographical distribution
limitation excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In
such case, this License incorporates the limitation as if written in the body of this License.
l. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new
problems or concerns.
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Each version is given a distinguishing version number. If the Library specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version
or of any later version published by the Free Software Foundation. If the Library does not specify a license version
number, you may choose any version ever published by the Free Software Foundation.
m.If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible
with these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the
two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse
of software generally.
NO WARRANTY
n. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
o. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING
BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED
BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

A.1.13. QtAV
© Wang Bin <wbsecg1@gmail.com> Shanghai University->S3 Graphics->Deepin, Shanghai, China 2013-01-21
**QtAV is free software licensed under the term of LGPL v2.1. The player example is licensed under GPL v3. If you use
QtAV or its constituent libraries, you must adhere to the terms of the license in question.**
Rather than repeating the text of the LGPL v2.1, the original text can be found in GNU LESSER GENERAL PUBLIC
LICENSE, Version 2.1 [26].

A.1.14. FFmpeg
Most files in FFmpeg are under the GNU Lesser General Public License version 2.1 or later (LGPL v2.1+). Read the file
`COPYING.LGPLv2.1` for details. Some other files have MIT/X11/BSD-style licenses. In combination the LGPL v2.1+ applies
to FFmpeg.
Rather than repeating the text of the LGPL v2.1, the original text can be found in GNU LESSER GENERAL PUBLIC
LICENSE, Version 2.1 [26].

A.1.15. c3.js
The MIT License (MIT) © 2013 Masayuki Tanaka
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify,
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merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

A.1.16. d3.js
Copyright 2010-2017 Mike Bostock All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met: * Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer. * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution. * Neither the name of
the author nor the names of contributors may be used to endorse or promote products derived from this software without
specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.
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